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The ESP Presentation tool allows you to quickly and easily build sales presentations that are
professional, customizable and shareable. Think of presentations as your tool for closing
more sales. How you present a product can make a remarkable difference in your client's
eyes.

Ready to get started?
Great! ASI is here to help you! What would you like to do?

Create a New Presentation
There are several ways to begin a presentation. Where are you starting from?

I'm a search results page
After marking a product, a toolbar will appear which will enable you to manage the product.
Click on the Create Presentation option. If you need to create a presentation with products
from multiple searches, save the products to the Clipboard first. To save products to the
Clipboard from a product search, mark the products, hover on the Copy To option on the
toolbar and select Clipboard.

https://kb.asicentral.com/en
https://kb.asicentral.com/en/kb
https://kb.asicentral.com/en/kb/esp-web-2
https://kb.asicentral.com/en/kb/presentations-and-projects
https://kb.asicentral.com/en/kb/articles/esp-presentations-2
https://kb.asicentral.com/en/kb/presentations-and-projects


I'm on the ESP Homepage
To create a presentation from the ESP Homepage, click on Presentations from the ESP Web
toolbar and select Create a New Presentation.

I'm in the Clipboard
To create a presentation with items saved to the Clipboard, click on the Clipboard icon.

You can mark one item, check specific products, or check the top checkbox to select all.
Once you have products selected, click on the Create Presentation option.



I'm in the Product Compare
From the Product Compare, mark the product(s) you would like to include in the
presentation. Then, click on the Add button. You can use the Create New Presentation
option to begin a presentation with the item(s) you selected.

I saved the Products in a Project Folder
Click on the Projects option from the main toolbar.

Locate the project folder where the products have been saved. Then, click on the Saved
Products tab. Mark the item(s) you would like to include in the presentation and then click
on the Create Presentation option from the available toolbar.



I want to Create a New Version of an Existing Presentation
If you want to copy a presentation, you will need to do so in the Projects area. Click on the
Projects option from the main toolbar.

Hover on a presentation listing to view management options: Download, Edit, Copy or Send.
Click on Copy.

Before you can begin customizing the product information, you will need to name and
assign the presentation. Type the Presentation Name, then assign it to a Customer and
Project Folder. By designating a customer, a copy of the presentation (including products)
will be saved in the CRM under that customer listing. In addition, select a Project Folder,
which will act as an online filing cabinet for all your presentations.
Note: If you want to add this presentation to a new project or customer, click on the Create
New link beneath Projects or New Customer to create them on the fly.

If you would like to share this presentation with other users within your company, use the
Visible to options to select:

Everyone: This presentation will be available for editing by all users within your
company.



Only the Record Creator: Only the user who created the presentation will be able to
view and/or edit this presentation.
Teams or Individuals: Select a sales team or designate specific individuals within
your company with whom you would like to share this presentation.

After entering this information, click on the Create button.

Edit an Existing Presentation
Edit the Presentation Details, Download, Share, Delete, or Send
Click on the Projects option from the main toolbar.

Hover on a presentation listing to view management options: Download, Edit, Copy or Send.
Click on Copy.



Edit the Product Information within the Presentation
Click on the CRM tab and then click on the Customers tab.

Locate the customer listing and click on their name.

Click on Presentations from the customer toolbar.

Hover on the the presentation you would like to modify and then click on the Edit link.



Add Products to a Presentation
If you created a presentation, you can click on the Add Products option or use the dropdown
arrow to add products. The only difference is that the dropdown arrow will bring you directly
into the option you selected.

There are three ways to add new products:

From a Project Folder
Click on the Projects folder option. All of the available project folders will be displayed below
the folder icon. Select the project where the items you would like to include in the
presentation have been saved. Then, click on the Add to Presentation button on the product
listing.

From a Product Search
Click on the Projects folder option. Enter the search term(s) in the white box below the



magnifying glass icon. When you click into the box, a price range search will also be
displayed. After entering your search keyword(s), click on the Go button. Use the guided
navigation to narrow the results by clicking a link in any of the available fields. Use the Sort
By dropdown to view the product results in a different order. After you have located the
product(s) you would like to include, click on the Add to Presentation button on the product
listing.

From the Clipboard
Click on the Clipboard option. All of the available items which have been saved onto the
clipboard will be displayed. Click on the item(s) you would like to include in the
presenatation. After you have located the product(s) you would like to include, click on the
Add to Presentation button on the product listing.



No matter where you added the products from (Project Folder, Search, or Clipboard),
clicking on the Add to Presentation button product will update the product listing to show
with a check mark and a remove button. A count of how many products are in the
presentation will be displayed above the presentations toolbar.

When you are finished adding products, you can use the Edit Products, Price Calculator,
Design, and Contact Info areas to customize your presentation.

Edit the Product Information
You are able to completely modify the product information for all items within a
presentation by clicking on Edit Products.



A thumbnail for each product in the presentation will be displayed below the Edit Products
options. The current product you are editing will show with a checkmark and all the product
information for that item will be shown below. If the presentation contains a lot of items,
you may need to use a horizontal scroll bar to view them all.

How would you like to modify the product information?

Change the order of the products
The order of the product thumbnails is the order of the products in the presentation. To
change the order, drag and drop the thumbnails to the order you would like.

You can also use the Sort By dropdown to sort the products within the presentation.

Remove a product from the presentation
To remove a product from the presentation, hover on the thumbnail image. Then, click on
the red circle with the white "X" icon.



Modify the information in a field
Hover on the product thumbnail to see the Edit Product button. Click on the Edit Product to
open the item in an editable state.

Then, click on the Edit link for the field where you would like update the information. Type
the new information in the Edit Product Detail field. You are also able to update the field
label for this product. If you would like to update the field label for all the products within
the presentation, you can do so in the Layout & Fields section of the Design area.

Click on the Save button when you are finished updating the information.

Change which fields are visible
The Show/Hide links in this area will apply to the individual product only.

You are able to show or hide fields for all of the products in the presentation within the
Design section. You are also able to save a template with specific visible or hidden fields by
selecting the fields in the Design area and then clicking on the Save as Template option. For
more information on how to do this, please review the Design section.

You can also hide price columns within an individual price grid using the checkbox above
the price break.



Use a different product image
If the supplier has provided multiple images for the product, a thumbnail for each additional
image will be displayed below the main product image. Use the arrow to scroll horizontally
through available images.

The available options for image replacement will vary depending on the item, however, you
can always upload an image from your computer to use in the presentation. Click on the
Upload a New Product Image link, browse your computer, locate the image file and then
click on Open.

If the supplier has enabled the image for virtual samples, hover over the image to make
your selection:

Show Catalog Image: Will display the default, standard image for the product from



the supplier's catalog
Show Blank Image: Will clear any existing logo from the image and show as blank
Show Virtual Sample Image: Will display the virtual sample logo image uploaded in
the Virtual Samples section of the Preferences area.

After clicking on an option, a prompt will appear asking if you would like to replace the
current image with your selection for all virtual sample enabled images within the
presentation.

Show my customer's logo on the product
You will be able to display your customer's logo on all virtual sample enabled images.
Virtual sampled enabled images will display with a wand icon.
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When editing the product, you will see the Create a Virtual Sample button below the image.
Click on that button to get started.
Note: If the image has the wand icon, but you do not see the Create a Virtual Sample
button below the image, it may be because the main product image for the product is not
virtual sample enabled. Scroll click on the thumbnail images to get to the virtual sample
enabled one(s).

For more information on creating virtual samples, please review the Virtual Samples in ESP
article.

Include Comments
At the bottom of the product listing, you have the option to enter comments about this
product. Comments can be viewed by the end user and you have the option to enable end
users to enter their own comments on the presentation.

For more information on using comments, please review the Comments section.

Modify the Pricing
To modify the pricing for multiple products in a presentation, use the Price Calculator
section. You also have the option to display the price grids in reverse (descending) order.
This option is available in the Settings tab.

How would you like to adjust the pricing?
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Use a Profit Margin
A profit margin is essentially the percentage of profit. To set the items to a profit margin,
select the "Adjust Prices based on Profit Margin" option and enter a numeric value in the
percentage box. Do not include the percentage symbol (%). Click on the Apply button to
make your changes apply to all or selected products.

Add or Subtract a Fixed Amount or Percentage
You can add or subtract - a percentage or a fixed amount - to or from the list price or the
net cost. Select the boxes for the action you would like to take and enter a numeric value in
the Fixed Amount or Percentage area. You can also choose to have the prices round up to
two decimal places instead of three. When you are finished, click on the Apply button to
make your changes apply to all or selected products.

I'm not sure. How is using a profit margin different than adding a
percentage?
If you're not sure whether to use a profit margin or add a percentage markup, it can be a
little confusing. Essentially, the profit margin is percentage of profit, whereas a markup is
how much of a percentage should be added to the list price.

So, how do profit margin and percentage markups differ in terms of determining the list
prices for the item(s)? In general, here is the difference:

Profit Margin:



Net Cost / (1.00-Profit Margin) = New List Price

Percentage Markup:

List Price from supplier * Percentage = Amount to be Added to Current
List Price
List Price from supplier + Amount to be Added to Current List Price =
New List Price

For more information, please review the Profit Margin versus Percentage Increase Reference
Guide.

Convert the Currency
Pricing for all products in a presentation can be converted from US dollars (USD) to
Canadian dollars (CAD) and vice versa. To convert pricing, click on the Manage Currency
link.

Use the dropdown to select which currency should be displayed on the presentation. Then,
use the conversion box to enter the exchange rate. Then, click on the Save button.

You will see a notification that the pricing has been updated in the presentation.
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I just want to edit the pricing for one product
To update the quantities and pricing for a product, locate the price grid for that item. Use
the individual boxes for quantities, list prices, and net cost. Type the new quantities and
pricing you would like to use and then click on the Save button. If you wanted to reset the
products to the supplier's list price, click on the Update All Products to Current ESP Price
link.

Design the Presentation
The Design dropdown contains two options: Themes and Layouts & Fields.

In the Themes section, you are able to:

Select the Orientation of the Presentation
Click to select the orientation of the presentation: portrait or landscape.

Choose a Theme and Color Scheme
Choose an available theme by clicking on the color swatch to use the theme in the selected



color scheme.

Create a Custom Theme
Click on the Create Theme option to upload a custom background image for a presentation.

You can upload your own backgrounds for presentations in a portrait (1600 pixels by 1200
pixels) or landscape (1200 pixels by 1600 pixels) orientation. Uploaded files must meet the
exact pixel dimensions. Name the theme and use the dropdown to select the font. To
change the text color, click on the color swatch and then select the color you would like to
use. Multiple background images can be applied to a single theme and assigned to specific
pages within the presentation, however, all files within the same theme must be the same
orientation. Click on Save when you are finished.



Configure the Header
In the Header layout, you can incorporate your logo into the header of the presentation by
clicking on the use the Select from Image Library to choose a logo from the Media Manager
or upload a new image. You can use the Layout dropdown to select how you would like your
logo and contact information to be displayed.

Note: To change the contact information on the header, go to the Settings section.

Configure the Footer
In the Footer layout section, you can incorporate your logo into the footer of the
presentation. Use the Select from Image Library to choose a logo from the Media Manager
or upload a new image. You can use the Layout dropdown to select how you would like the
footer to be displayed. Use the Edit Content button to customize the footer to display text
such as your web address. Check the Show page numbers box to add page numbers to your
presentation.



In the Layouts & Fields section, you are able to:

Choose How Many Products per Page
Hover on the arrows to the left and right of the product layout thumbnails to scroll through
the available options:

1 product per page with a large image
1 product per page with more details
2 products per page
3 products per page
4 products per page
6 products per page
12 products per page

The data fields that are the standard for each template are denoted with the eye icon in the
Product Fields section below.

Manage Product Fields
You are able to select which fields are displayed on the presentation using the Visible
checkbox. The standard fields for each template will automatically be marked and denoted
by the eye icon to the far right. You are able to uncheck the visible checkbox to not display
a field for any products in the presentation. When determining the amount of fields to
display, be mindful of the amount of standard fields for the template because adding more
than the default number of fields may cause formatting issues. For example, if you are
working with the 12 products per page layout, there is only space for a few fields. However,
if you are working with the one product per page layout, you can show much more
information for each item.

Here is the number of default fields for each layout:

1 product per page: Image, Price Grid with Price Includes Statement and 12



additional fields
1 large product per page: Image, Price Grid with Price Includes Statement and 7
additional fields
2 products per page: Image, Price Grid with Price Includes Statement and 7
additional fields
3 products per page: Image, Price Grid with Price Includes Statement and 7
additional fields
4 products per page: Image, Price Grid with Price Includes Statement and 7
additional fields
6 products per page: Image, Price Grid and 3 additional fields
12 products per page: Image, Price Grid and 3 additional fields

Each product field within a layout will be displayed with a customize label name box. Click
into the box and type the new field label. If you would like to save these labels and layout
for future presentations, use the Save as Template link.

You can also change the order of the Product Fields by clicking on the three vertical dots to
the left of the order number, then dragging and dropping the field to a new location. The
numbers will change automatically to reflect the new order of the product fields.

In the example below, the Description is made visible, while the Summary is hidden. Then,
the Description is moved to the top spot and the Product Number is relocated to the third
spot before being renamed to "Reference Number".

Settings

In the Contact Info section, use the Presentation Details section to edit the presentation
title, customer name, and your contact information. If you have chosen to use a header,
editing information in this section will automatically update the header.



If you would like to share this presentation with other users in your company, you can use
the Visibility settings to share it with Everyone (all ESP users within your company) or
Teams or Individuals within your company. If you select the Everyone or Teams or
Individuals, a checkbox will appear enabling you to select if you would like to allow other
users to copy the presentation.

The Price Grid Sorting option enables you to check the Reverse Price Grid Columns box to
have the quantities in the price grid displayed in a descending order. It is important to keep
in mind that checking this box will not change the price grids within the presentation
builder, but will be shown on output documents.

Click on the Save Presentations Details button when you are finished.

Also in this section, you are able to choose if you would like to use a Cover Page, Contact
Page, Introduction Page, and/or Closing Page. You can add images to these pages by
clicking on the Select from Image Library button. If you do not wish to include these pages
within your presentation, uncheck the Show Cover Page and Show Contact Page
checkboxes.

You can select an introduction page and closing page by using the dropdown. You can edit
this information by clicking on the edit button below the available preview boxes. You can
also create a new one using the Add New button. If you do not want an Introduction or



Closing page, use Select Introduction Page and Select Closing Page from the drop down
menus.

Manage Comments
Presentation comments enable you to communicate directly through the presentation with
the end-buyer. Comments will be included with the product information on the presentation
and (if you have enabled this function) the end-buyer can enter reply comments.

If a customer enters comments on an ESP Presentation, a notification will appear in-app, as
well as be emailed to you.

To manage all comments for a presentation, click on the Comments option from the toolbar.
In this section, you will be able to view any comments entered by users within your
company, as well as those provided by end-buyers. To disable end-buyer comments,
uncheck the "Allow end-buyer comments" box.



Click on the "X" to remove a comment.

Send and/or Share
There are several sending and sharing options on the Presentations Toolbar.

Copy
Click this option to create a duplicate of this presentation. Type the Presentation Name,
then assign it to a Customer and Project Folder. By designating a customer, a copy of the
presentation (including products) will be saved in the CRM under that customer listing. In
addition, select a Project Folder, which will act as an online filing cabinet for all your
presentations.
Note: If you want to add this presentation to a new project or customer, click on the Create
New link beneath Projects or New Customer to create them on the fly.

After entering this information, click on the Create button.



Save As Template
Save the current template as a custom template for use on future presentation. Enter a
name in the Template Name box. Click on Save. Your custom template will now be saved in
the ESP Presentation Manager and able to be used for all future presentations



Share
The options for sharing presentations are:

Copy Links:

Click on the copy icon at the end of the HTML or PDF link to share a
direct link to the presentation in the format you would like.

Export to Microsoft PowerPoint:

Export to PowerPoint offers you the ability to completely personalize
your presentation. To include hidden field from the presentation in the
Notes section of the PowerPoint presentation, check the Include hidden
product fields in notes box and then click on the Export to PowerPoint
button. Any fields you have hidden in the presentation will now be
added to the Notes section of the PowerPoint presentation.

The following versions of PowerPoint are supported by ESP
Presentations:

Windows:
PowerPoint 2007
PowerPoint 2010
PowerPoint 2013

Mac OS X:
PowerPoint for Mac 2011 14.2.0
PowerPoint for Mac 2011 14.3.2

Publish to ESP Websites:

You can also publish this presentation to your ESP Website or Company
Store. Click on the Publish to Websites tab.



In this tab, check the box that corresponds with the site(s) to which you
would like to publish this presentation. Send the link to your customer
so they can view the presentation on your website and order the
products they are interested in. After making your selection, click Save.

Download
Click on the Download link to save the presentation as a PDF on your computer.

Preview
Open the presentation in a new tab so you can look it over before sending and sharing it.
Close the tab when you are finished previewing.

Send
To email the presentation, click on the Send button. Begin typing your customer's email
address in the Send Presentation window. Then, you are able to customize the email subject
line and message. Use the Preview to open the presentation in a new tab so you can look it
over before sending. Close the tab to return to the sending page. You can also save a copy
of the presentation in a PDF format to your computer by clicking on the Download button.
Click on Print to print the presentation.

Once you are finished, click on the Send Presentation button.



When you are finished editing, updating, and sending/sharing your presentation, it will be
saved in the Projects area. If you selected a customer, the presentation will also be stored
in the Customer record in CRM.
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